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Introduction 

Welcome to TheBrain 12! Just when you thought your brain couldn’t get better, 
TheBrain 12 makes connecting information virtually effortless. With seamless 
discovery of related content, automatic display of backlinks, and a redesigned 
Content Area, your ideas and knowledge will come to life like never before. 

TheBrain 12 new features include: 

 Sleek New Redesign of the Content Area 

 Viewing Related Thoughts in the Content Area 

 Faster Ways to Create Thoughts and Links 

 Viewing Attachments in Slideshow Mode 

 Dragging and Dropping Images, Links, and Text within Notes 

 Merging Thoughts 

 Encrypting Individual Attachments  

 And many other Enhancements … 

A video overview of these features is available at 

https://www.thebrain.com/TheBrain12 

About this Guide 

This guide covers the new features and changes in TheBrain 12 that have been 
made since version 11. It is intended for people who are already familiar with 
version 11.  

 

https://www.thebrain.com/TheBrain12
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Redesigned Content Area 

You’ll find that the Content Area is now simpler, with a more space-efficient 

design.  

 

Figure 1. The Content Area 

Specific enhancements include: 

• Increased speed—all types of attachments are added more quickly. 

• Improved drag and drop for attachments—the thought name is 
highlighted as you drag and drop, and once dropped, the attachment 
shows below the thought name, instead of on a separate tab.  
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Figure 2. Dragging and Dropping an Attachment 

• You can insert images and URLs directly into notes—just drag and 
drop the item within the body of the text area. 

 

Figure 3. Dragging and Dropping an Attachment 

• Events are shown directly in the Content Area—previously, they were 
listed on a separate Events tab within the Content Area. 

 

Figure 4. Events Appear at the Top of the Note 
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• The thought name appears as a title at the top of the Content Area—
and, of course, if you edit the title here, the thought is renamed globally, 
and vice versa. You can hide the title using the Include title option on the 
Notes Editor tab in Preferences. 

 

Figure 11. Show or Hide the Thought Title in the Content Area 

• Enhanced web content display—web pages from URLs in notes are 
displayed in TheBrain’s embedded browser. 

 

 

BrainBox also utilizes this redesigned Content Area. You can also give 
BrainBox its own tab by clicking its icon, clicking the drop-down Show 
Commands menu, then selecting Open BrainBox in New Tab. 

 

New Note Features 

Capture and Insert Image in Notes 

The Notes toolbar now has an option to capture and insert an image. 

▪ Click the Capture and Insert Image button in the Notes toolbar. 

▪ Your brain will be hidden temporarily and red crosshairs will appear on the 

screen in place of your cursor. 

▪ Click and drag a rectangle around the area to be captured as an image in 
your note.  
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Figure 5. Capture Image from the Notes Toolbar 

Details on Images in Notes 

Select an image in a note to see its size as a percentage. 

 

Figure 6. Image Size Displayed as a Percentage When Selected 

Collapsing and Expanding Notes Sections 

Now you can collapse sections of your notes based on headings, tables, and list 
items. This helps you navigate through large documents more easily. Collapsing 
lets you focus on a particular area while writing or reviewing content. When 
you’re ready, you can expand any or all sections. 
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Two ways to expand or collapse Notes sections: 

• Hover over the area to the left of the notes, then click the down-arrow to the 
left of the section to collapse the entire list. This symbol will become a right-
arrow which you can click to expand the section. 

Or 

• Right-click in the Notes area, then click an option of your choice. Optionally, 
before you right-click, click in a specific section if you want to collapse or 

expand just that section. 

Choices on the context menu include: Collapse All Except Here, Expand All, 
Collapse All, Expand Here, and Collapse Here. 

 

Figure 7. Options for Expanding or Collapsing Note Sections 

Table of Contents 

Easily add a Table of Contents into any existing note. The Table of Contents will 
provide quick links to all Titles, Subtitles, Headings and Subheadings. 

To insert a Table of Contents: 

• Place your cursor in the desired location. 

• Click the Table of Contents icon in the Notes toolbar or type [/toc/]. 

• The Table of Contents that is created will only be for content that is below 
its location. 
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Figure 8. Table of Contents 

Pop Up Table of Contents 

For a quick pop up window that contains the note’s Table of Contents, right-click 
in the note or press Ctrl+T. 

 

Figure 9. Pop Up Table of Contents 
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View Related Thoughts in the Content Area 

Have you ever wondered whether content in one thought’s note is referencing 
another thought in the same brain or even if the thought you are on is being 
referenced in another note—but you figured it might be too complicated to go 
searching? You’ll love these new features. In TheBrain 12, without doing a thing, 
you’ll instantly be presented with all related thoughts in the Content Area.  

 

Related thoughts do not have to be visible in the Plex in order to display in 
the Content Area. 

 

Thought Mentions 

When a thought name appears within notes, your brain recognizes it 
automatically as a “mention.” Both plural and singular forms of the text are 
recognized, so exact matches are not required. 

 

Figure 10. A Thought Mention Underlined in a Note 

Right-click on a Mention in a note to either link to or activate this thought. 

 

Figure 11. Context Menu When Right-Clicking on a Mention 
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Below the note, users have the option of displaying more related content within 
the same brain by opening Mapped Links, Backlinks, or Unlinked Mentions in a 
footer that can appear below the note: 

Mapped Links: Thoughts that are connected in the Plex as parents, 
children, jumps, or siblings (but do not necessarily 

have text in common) 

Backlinks: Thoughts whose notes link to the active thought 

Unlinked Mentions: Thoughts whose notes contain the name of the 

active thought⎯even if not explicitly linked 

While mapped links refer to thought names, backlinks and mentions display both 
the names of the related thoughts and the context of the notes in which they 
appear. 

 

Figure 12. Content Area with Related Thoughts in the Footer 

Using Related Thought Links 

You can open any related thought by clicking its link in the Content Area footer. 
This enables you to add content to one note from another via links or mentions. 
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Figure 13. Two Kinds of Links for Related Thoughts 

• Click a solid blue link to activate that thought. 

• In the footer, click a dashed underline link to display the Link this Mention 
command. Once it’s linked to the existing mentioned thought, it will move 
from the Unlinked Mention section to the Backlinks section in the 
Content Area. 

 

Figure 14. After an Unlinked Mention is Linked 

 

Note that while links appear in blue by default, you can easily change their 
color. To do so, select Brain Theme in the Options menu, then click the color 
of your choice on the Colors tab for the Links entry. Click Save Theme to 
save your change. 
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Figure 15. Changing Link Color for the Current Theme 

Hiding or Showing Related Thoughts 

To hide mapped links, backlinks, or unlinked mentions in the Content Area: 

• Right-click below the notes, then click Show Mapped Links, Show 
Backlinks, and/or Show Unlinked Mentions in the context menu. 

To restore the thought names and/or links and mentions: 

• Right-click within the Notes area and click Show Mapped Links, Show 
Backlinks, and/or Show Unlinked Mentions in the context menu. 

Note that hiding or showing related thoughts is global and applies to your entire 
brain. 
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Figure 16. Context Menu Below Notes 

You can also use the Notes Editor tab in Preferences to hide or display links 
and mentions in the Content Area. 

 

Figure 17. Links and Mentions Section in Notes Editor Preferences 

Collapsing and Expanding Related Thoughts Sections 

When you hover over the area to the left of the related thoughts, you’ll see down- 

and right-arrows.  

• Click the down-arrow to the left of the current thought name to collapse the 
entire list. This symbol will become a right-arrow which you can click to 
expand the entire list. 

• Click any other down- or right-arrow to expand or collapse that section or item. 
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Figure 18. Collapsing or Expanding Sections 

You can also collapse and expand sections within note text in a similar way when 
Heading styles are used  

Aggregating Content 

The data in your brain can be aggregated automatically with just a few simple 
mechanics. When data is aggregated you can see content from notes about the 
same subject throughout the thoughts in your brain all at the same time. This 

ability is powerful and magical! 

In the example below, the four backlinks comprise every note that begins with a 
“George” heading throughout the brain, organized by the name of the thought 
that contains one or more “George” headings. 
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Figure 19. Aggregated Data for “George” 

To prepare data to be aggregated: 

1. Create a thought whose name represents the information you want to see 
aggregated. In the Figure 19 example, that thought name is “George.” 

2. In any thought that has information about “George” (following this example), 
precede the information with a standalone paragraph. This paragraph 
should simply have the text that matches the name of the thought for which 
you want aggregated data—“George” in our example. The text should be 
attached to a Heading stye.  

 

Figure 20. “George” is Formatted as a Heading 3 

3. Link the Heading by right-clicking it, then selecting Link (thought name). 
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Figure 21. Linking the Heading to the Thought of the Same Name 

4. In this scenario, the backlink content on the George thought will display all 
text until it comes to the next #3 (Heading) formatted text.  

Any time you activate the “George” thought, you’ll see the information 

aggregated, as in Figure 19.  

View Attachments as a Slideshow 

The new Next and Previous navigational arrows in the top-right corner of the 
Content Area toolbar make it easy to browse through attachments or pictures 
within your notes. 
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Figure 22. Next and Previous Arrows 

To view attachments as a slide show: 

• Click the first attachment, then click the Next button to display the next 
attachment. 

• For multi-page attachments, click a thumbnail to jump to a specific page. 

• To return to the notes, just click the Close button (X) at the start of the 
Notes toolbar (or keep clicking the Previous button until the notes appear). 

To view pictures in notes as a slide show: 

• Double-click the image you want to see first to maximize it, then click the 
Next button to display the next picture. 
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Figure 23. A Picture from Notes in Slideshow Mode 

Quick Thought Creation 

Create Thoughts from Search, Notes or Events 

Now you can create a new thought instantly from the Search box or within Notes 
or Events. 

Say you’d like a “Monthly Meetings” thought to be a child of “My Work,” but 
you’re not sure whether you already have a thought with that name. You can 
begin by searching, and if it doesn’t already exist, no need to retype the name.  

To create a new thought using search: 

1. Activate the thought that should be the parent, child, or jump thought of the 

new thought. 

2. Click in the Search box at the top-right corner of the window, then type the 
name of the thought you’re looking for, or want to create if it’s not found. 

3. If the thought doesn’t already exist and you want to create it: 

• Press the Enter key to create it as a child of the active thought, or 

• Hold down the Shift key as you press the Enter key to create it as a 
parent of the active thought, or 
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• Hold down the Ctrl key as you press the Enter key to create it as a jump 
thought of the active thought, or 

• Hold down the Ctrl key as you press the Shift key, then click on Create 
Orphan to create it as an orphan thought 

Your new thought will be the active thought. 

 

Figure 24. Creating a Thought from the Search Box 

To create a new thought when searching finds an existing thought: 

1. Press the up-arrow key. This highlights the default option—Create Child. 
Note that pressing the Enter key before pressing the up-arrow key 
activates the existing thought.  

 

Figure 25. Creating a Thought from the Search Box when the Thought is Found 

2. Use any of the same key combinations for creating a new thought from the 
Search box when a thought isn’t found. 

To create a new thought from within a note: 

1. Select the text within the note for which you want to create a child, parent, 

or jump thought. 

2. Right-click the selected text, then click the Insert Thought or Web Link 
command. Optionally, you can revise the text in the new box that appears, 
if you want a different name for the new thought. 
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3. Select a relationship for the new thought: 

• Press the Enter key to create it as a child of the active thought, or 

• Hold down the Shift key as you press the Enter key to create it as a 
parent of the active thought, or 

• Hold down the Ctrl key as you press the Enter key to create it as a jump 
thought of the active thought 

 

Figure 26. Creating a Thought from a Note 

To create a new thought from within an Event: 

1. Open an existing Event or click and drag from the start to finish times in the 

timeline to create a new Event. 

2. Type a name for the new thought where you see “No thought or link” at the 
top of the Event box. A new orphan thought will be created with that name. 

 

Figure 27. Creating a Thought from an Event 
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Keyboard Shortcut to Create an Orphan Thought 

Create an orphan thought using F9 on Windows or Opt+Cmd+Right on macOS. 

 

Figure 28. Default Keyboard Shortcut for Create Orphan 

Fast Linking and Creating from Notes 

Pressing Ctrl/Cmd+K is a shortcut to: 

• Insert a link to an existing thought 

• Create a new thought 

• Link to a URL 

• Edit or remove a link 

After you press Ctrl/Cmd+K:  

1. An edit box opens so you can begin typing a URL or the name of the 
thought you want to perform any of these activities on. Or, if you select text 
or a URL first, that text will appear in the edit box.  

2. Double-click the entry that appears to insert a link to that item in the note. 
For example, double-clicking “Volunteer Opportunities” in the example 

below creates a link to that thought in the notes for “Goals.” 
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Figure 29. The Ctrl/Cmd+K Shortcut 

2. If an existing link is selected, you’re ready to begin editing it. To remove the 
link, just delete its name in the edit box. 

3. If you type a URL, it will be inserted. 

The link command includes all the features of Quick Thought Creation so you 

can insert all types of relationships easily. 

 
Alternatively, you can type [[ to link or create thoughts. 

Using Drag and Drop within Notes 

Now you can move images, links, and text in a note via drag and drop. You can 
also drag note content to external applications. 

To move text: 

• First select the text, then drag the selection 

To move an image or link 

• Start dragging it, then drop it when the cursor is where you want the image 
or link to be 

Want to stop dragging? Just press the Escape key. 
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Other New Notes Features 

You’ll find the following when you begin using Notes in TheBrain 12:  

• Thought and URL links have a cleaner look—the trailing icon is gone. 

• Your notes text now has improved kerning—the spacing between letters—
and better text shaping. 

• There is rudimentary support for right-to-left script (for example, text in 
Hebrew or Arabic). 

• When note text is selected and you paste in a URL, the selected text is 
automatically linked to the URL. 

• By default, “smart quotes” (differentiated quotation marks) are inserted 
automatically. This means that the opening quotation mark looks different 
from the closing quotation mark you insert before and after words or 

phrases. 

• When you rename a thought, any references to it from other notes are 
automatically updated with the new name. 

• You can create your own keyboard shortcuts to switch text justification in 
notes between left, center, and right. Go to the Keyboard tab in 
Preferences and expand the Notes section. 
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Figure 30. Creating Keyboard Shortcuts for Text Alignment in Notes 

• You can toggle to a "compact" Notes toolbar from the toolbar itself. 

 

Figure 31. Expanding the Compact Toolbar from the Toolbar More Command 
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• Under Windows you’ll notice improved scrolling when you’re using the 
mouse wheel or touchpad. 

Additional Notes enhancements are described in the sections below. 

Content Only Mode 

You can access most features and functionality right from within the Content 
Area. This means that the Plex can be hidden while you concentrate on writing 
and other tasks that are easier in a larger work space. 

Previewing Notes in the Plex 

With the optional Show notes indicators preference enabled in the Plex, small 
icons appear on thoughts containing notes. Now, you can hover over these icons 
to get an instant view of the corresponding note. 

 

Figure 32. “Show notes indicators” is Enabled 

Content previews also appear, by default, based on Search box results. This 
setting is on the Behaviors tab in Preferences. 

 

Figure 33. “Show content previews when searching” is Enabled 
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Figure 34. Content is Shown on Hover Over Notes Icon 

More Stylish Notes Styles 

Your headings can be more expressive—you have access to ALL CAPS, 
variable letter spacing, and alternative colors. You also have more control 
over sizing.  

• New commands to copy, paste, import, and export styles make it easier to 
create new styles. 

• A variety of new built-in styles are also included. Prebuilt styles are 
grouped into Light, Dark, and Fun sections. 
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Figure 35. TheBrain 12 Edit Notes Style Window 

To modify styles: 

1. Click the More button, then click the Notes Style command (or if the Notes 

toolbar is expanded, just click the Notes Style icon). 

 

Figure 36. Opening the Edit Notes Style Window 

2. Right-click within the sample text of the item you want to change, for 
example, “Heading Example Text.” 
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Figure 37. Choice for Formatting Styles 

3. Click the Apply button or press the Enter key to save your change and 
close the window. Your change will be made in all notes that have those 

headings. 

 

Figure 38. Before and After Changing the Heading Style to “All Caps” 

Keyboard Shortcut for Links, Attachments, and 
Check Boxes in Notes 

When your fingers are already on the keyboard, there’s a new keyboard shortcut 
in town that can save you a mouse click: Ctrl/Cmd+L 

1. Make sure the text cursor is already blinking someplace within the note, 
then use the standard navigating keys to move the insertion point to any of 
these items: 

• An item in a check box list 

• A link 
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• An attachment 

2. Press Ctrl/Cmd+L to toggle a check box on or off, follow a link, or open an 

attachment. 

 

Figure 39. Pressing Ctrl/Cmd+L Will Open the Link 

Tab Key Functionality in the Notes Editor 

When you’re typing in the Notes editor, the Tab key performs different functions 

based on: 

▪ Where the cursor is  

▪ Whether text is selected 

 

As in most text processing software, holding the Shift key while pressing the 
Tab key reverses the direction of the action. For example, wherever pressing 

Tab shifts text to the right, pressing Shift+Tab shifts text to the left. 

If no text is selected and the cursor is within or at the start of a paragraph: 

▪ The first line of the paragraph (whether it is one line or many) is indented 
approximately five spaces each time the Tab key is pressed.  

When the cursor is in a list item (bullets/check boxes/numbered lines): 

▪ The entire list entry is indented approximately five spaces each time the Tab 

key is pressed.  

When the cursor is in a title, subtitle, heading, or subheading: 

▪ The level of the heading is decreased each time the Tab key is pressed. The 
heading level is increased each time Shift+Tab is pressed. For example, to 
change a Heading 4 to a Heading 3, you would click in the text and press 
Shift+Tab. (Heading 3 is a “higher level” than Heading 4.) 
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When the cursor is in a table: 

▪ Pressing the Tab key moves the cursor to the next cell. 

 

Tab characters can’t be inserted into the middle of a line of text. If you want to 
align text into columns, it’s most efficient to format using a table. 

Enhanced Image Handling 

Create Icons from Images in Thoughts 

Now you can use an image from notes or attachments in the active thought as 

the thought’s icon. 

To create a thought icon from an image in Notes: 

▪ Click the image to select it, right-click it, then click the Copy to Icon 
command in the context menu. 

 

Figure 40. Copy to Icon Command in the Image’s Context Menu 

To create a thought icon from one of its attachments: 

▪ Right-click the attachment, then click the Copy to Icon command in the 

context menu. 
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Figure 41. Copy to Icon Command in the Attachment’s Context Menu 

The new icon will appear to the left of the thought name at the top of the Content 
Area and on the active thought in the Plex. 

 

Figure 42. Thought with its New Icon 

Copy Wallpaper Button 

Easily copy your brain’s wallpaper to your clipboard from the Brain Theme 
dialog. 
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Figure 43. Copy Wallpaper Button 

Enhanced Search Capabilities 

Say you’re searching for something and come up with no hits. For example, 
you’re on a neighborhood committee and you’ve volunteered to look into an issue 
with squirrels. You type “squirrels” in the Search box. No results? Press the F4 
key to search the web. 

 

Figure 44. Search Engine Choices 
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▪ Click the drop-down arrow if you want to select a different search engine, 
then click the Search button to begin searching the web based on what 
you’ve typed. 

▪ When you find a site you like, you can add it to any thought in the usual way. 
The Web Search box will close automatically after you click the Search 

button. 

To modify, add, or reset search engines: 

▪ Click the Edit button in the Web Search box 

 

Figure 45. Editing Search Engine URLs 

To customize the search engine choices: 

▪ Click and edit any URL string to customize it, or 

▪ Click the Add New button to enter a name that isn’t already in the list, or 

▪ Click the Reset button to return to TheBrain’s default choices 
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Click the OK button to save your customizations or click the Cancel button to 
close the box without making changes. The original Web Search box will still be 
open, still showing the text you were searching for. 

New Dynamic To-Do Lists 

Now your To-Do lists can practically complete themselves! Just as in previous 
versions of TheBrain, you can create To-Do lists within notes by attaching text to 

the Checkbox List style. 

 

Figure 46. A Check List in a Note 

As before, when you complete an item, you can click the check box and it’s 

virtually checked off your list. 

 

Figure 47. A Completed To-Do Item 

Now you can see ALL of your To-Do items in one place. To do so: 

▪ Click the Right Panel button in the upper-right area next to the Search box or 
click the To Do List command on the View menu.  
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Figure 48. Two Ways to Open the To Do List for All Thoughts 

The To Do List panel is displayed: 

 

Figure 49. Two Ways to Open the To Do List for All Thoughts 

 

When you click a check box in one location, such as the To Do List panel, it is 
automatically checked off in the other location (the thought) and vice versa. 

Merging Thoughts 

Now you can automatically merge multiple thoughts that refer to the same thing. 
You can combine the links, attachments, and notes so that the resulting thought 
has all of the information from those multiple thoughts. 

To merge thoughts: 

1. Ctrl+click on two or more thoughts that you want to merge into a single 
thought. The thought names will automatically appear in the Selection box. 
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2. Right-click in the selection box, then click Merge (n) Thoughts. 

 

Figure 50. Merging Three Selected Thoughts into One 

When you activate the new thought, you’ll see all content that was in each of the 
standalone thoughts. The name of the new thought becomes a combination of 
the formerly separate thoughts, in alphabetical order. 

 

Figure 51. Original Content Area of Three Thoughts before Merging  



 Generate a Report Based on Attachment Size 

Transitioning to TheBrain 12 36 

 

Figure 52. After Merging  

Generate a Report Based on Attachment Size 

Now you can sort your thoughts by total attachments size. 

To run a report based on total attachments size: 

1. Click the Report command on the View menu to open the Reports panel. 

2. Click Attachments Size in the Sort drop-down list. 

 

Figure 53. Attachments Size Sort Option  

The thoughts with the largest total attachment sizes will display highest in the list. 
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Encrypting Individual File Attachments 

Now you can encrypt Individual file attachments within your brain using the 

Encrypt command on an attachment’s context menu. 

AES 256 bit encryption ensures that without the password, it is impossible to 
recover the file contents from the encrypted file—even with administrator access 
to the machine where the file is stored on a local computer or remote cloud 

server. 

Encrypted files cannot be searched and can only be decrypted via Windows and 
macOS versions of TheBrain. These files are completely inaccessible even to 
your hosting provider whether that be a private TeamBrain Enterprise Server or 

TheBrain Technologies Cloud Server. 

To encrypt a file: 

1. Right-click the attachment, then click Encrypt in the context menu. 

 

Figure 54. After Clicking on the Attachment’s Context Menu 

2. Type in the prompt you want the user to see when they attempt to open the 
file, type a password, click the check box confirming that the file cannot be 
opened if the password is lost, then click the Encrypt button.  
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Figure 55. Example Encryption Details 

3. Whenever someone attempts to open the file, they’ll see the prompt you 
entered. They will have to enter the correct password, then click the 
Decrypt button. After that the file can be opened by clicking on it. 

 

Figure 56. Decrypting and Opening the File 

More Improvements Throughout 

You’ll find many other enhancements throughout TheBrain 12. Here are some of 
the highlights: 

• You can find and execute commands from the Search box. To begin, type 
a forward slash (/) in the Search box. An alphabetical list will appear. The 
list will be fine-tuned to match what you type. 
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Figure 57. Executing a Command from the Search Box 

• The Wander algorithm has been improved so that you’ll be less likely to 
revisit the same thoughts. 

• The initial startup time has been improved along with other performance 
optimizations. 

• There’s better rendering of forgotten thoughts in the Plex. 

• Event colors now inherit from associated thoughts. 

• Events now support spellcheck and markdown formatting in the 
descriptions. 

• You can create a thought and attach a URL in one step by entering a URL 
in either the thought creation or Search box. 

• There are many additional Preference settings available to suit your 
personal workflow. 

• Ability to multi-select attachments in BrainBox when it’s in a new tab. 
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Figure 58. Executing a Command from the Search Box 

• Intelligence has been enhanced to recognize plural and singular forms of 
the same word. This helps find context-sensitive matches in irregular 

cases such as phenomenon and phenomena. 

• Now you’ll see clear Search feedback when searches are fully completed. 

• Dark Mode has been enhanced so that check boxes and window pop-ups 
have more contrast. 

• Contact TheBrain Support Team right from within TheBrain app. 

 

Figure 59. Contact Support 

• When you download new updates of TheBrain and the process is 
complete, you’ll see a more informative prompt now. You’ll also be able to 
choose whether you’d like to restart TheBrain immediately or wait until 
another time. 
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• When it’s necessary to sync or to open a recently synced brain, you’ll see 
a more informative prompt. 

• Sibling thoughts are not shown when there are more than 50 parents. 

• Ctrl/Cmd + click opens a brain in a new tab from the brains list page. 

• The Brain Access and Sharing panel is now accessible from the brain 
list, even if there is no local copy of this brain. 

 

Figure 60. Brain Access Options on Remote Brains 

 


